MONSOON
Operating Instructions
For the WIYN Bench Spectrograph

NOAO Document MNSN-AD-08-0010
Revision: 2.0

Authored by:
David Mills and David Sawyer

Please send comments:
dsawyer@noao.edu
## Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date Approved</th>
<th>Sections Affected</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>3/14/2008</td>
<td>All</td>
<td>Initial draft release - aro</td>
</tr>
<tr>
<td>1.0</td>
<td>6/25/2008</td>
<td>1 thru 6 and 9</td>
<td>New MOP interface, new power up and power down procedures</td>
</tr>
<tr>
<td>1.1</td>
<td>7/2/2008</td>
<td>Various</td>
<td>Specify mouse buttons used when navigating MOP. Expand information on “Stop and readout image.” Expand PAN reset instructions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.1</td>
<td></td>
</tr>
<tr>
<td>1.2</td>
<td>7/9/2008</td>
<td>3.1</td>
<td>Expand explanation of exposure configuration. Expand note on use of ximtool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.0</td>
<td></td>
</tr>
<tr>
<td>2.0</td>
<td>7/15/2008</td>
<td>As required</td>
<td>Replace MOP GUI throughout. New MOP has an entry for “propid.” Define “propid”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3.2</td>
<td></td>
</tr>
</tbody>
</table>
List of Figures

Figure 1 – Start Bench PAN ................................................................. 5
Figure 2 – PAN Not Active ................................................................. 6
Figure 3 – Initializing Camera ........................................................... 6
Figure 4 – MOP Startup ................................................................. 7
Figure 5 – MONSOON Observing Platform GUI ......................... 8
Figure 6 – Reconfigure ................................................................. 9
Figure 7 – Current Settings ......................................................... 10
Figure 8 – Exposure Configuration ............................................ 12
Figure 9 – User Data ................................................................. 13
Figure 10 – Selecting Image Name and Storage Location ........ 14
Figure 11 – Directory Selection ................................................. 15
Figure 12 – Comments Area ...................................................... 16
Figure 13 – Exposure Start .......................................................... 17
Figure 14 – Exposure Status ...................................................... 18
Figure 15 – Pause .................................................................. 19
Figure 16 – Image Readout Status ................................ .......... 20
Figure 17 – Data Transfer .......................................................... 21
Figure 18 – Disk IO ................................................................. 22
Figure 19 – DS9 Image Display Window .................................... 23
Figure 20 – FITS Header Display ............................................... 24
Figure 21 – Typical MOP Debug Log ........................................ 25
Figure 22 - Typical MOP Debug Log with Errors .................. 26
Figure 23 - MOP Debug Log after Successful PAN Reset .... 26
1.0 Introduction

This document sets forth instructions for operating the MONSOON Observing Platform (MOP) as it applies to the WIYN Bench Spectrograph. Graphical User Interfaces (GUI) are represented throughout this manual and serve to clarify many of the operational features of the MOP.

2.0 Starting the System

Power on DHE, if not previously accomplished.

Log in as “observer.”

2.1 Start the Software

The Monsoon Observing Platform software has one major prerequisite. The data acquisition software on the Pixel Acquisition Node (PAN) machine must be up and running.

Start the Bench PAN software by left clicking on the Start benchPAN icon on the desktop.

The Start benchPAN terminal window will open along with panCapture and panSaver windows. These windows can be minimized to save desktop space. See Figure 1. The panDaemon and panProcAlg windows, which contain the interface and data preprocessing processes, are started minimized.

![Start Bench PAN](image)
To start the MOP, left click the Start MOP icon on the desktop.

**NOTE:** If the PAN software is not running, a small dialog box will also appear indicating a problem. See Figure 2.

![PAN Not Active](image)

See Section 6.1, Troubleshooting, for PAN restart instructions.

Restart the PAN and left click OK. The window will no longer be displayed if PAN start was successful.

Four new windows will open:

- MONSOON Camera Control window
- MOP Debug Log Viewer
- A DS9 Image Viewer
- MOP Command Link Interface

“Initializing camera” appears briefly, as shown in Figure 3, then disappears leaving the monitor screen as depicted in Figure 4.
MOP Startup

Figure 4

The MOP window can be minimized at this time but it is recommended that the MOP debug log window be left open to monitor the health of the software.
3.0 MOP GUI Interface

The Monsoon Camera Control – bench screen allows system configuration by means of pull-down menus across the top of the screen and several text entry areas. See Figure 5

![MONSOON Observing Platform GUI](image_url)

Figure 5
The pull-down menus are:

- **File**
  
  The File menu has only one option:
  
  Exit – closes the MOP interface.

- **Gain**
  
  The Gain menu provides three options:
  
  Low 0.8e-/ADU – low conversion gain, 0.876 electrons per ADU.
  Med 0.4e-/ADU – medium conversion gain, 0.438 electrons per ADU.
  High 0.2e-/ADU – high conversion gain, 0.219 electrons per ADU.

  **NOTE:** The conversion gains listed are for the right amplifier of CCD STA1042-5644.

When a gain selection is made, the Mode Summary section of the window will display a brief message, “Reconfiguring readout mode”, and then will display the new setting. See Figure 6. The conversion gain will affect read noise and readout time. These are displayed in the Mode Summary area of the *Monsoon Camera Control* screen. See Figure 7.
The Bin menu provides a selection of row/column binning options. Binning selection will affect the readout time and will be updated and displayed in the Mode Summary area of the Monsoon Camera Control screen. See Figure 7.

1x1 – no binning
2x1 – two-pixel binning for columns, no binning for rows
2x2 – two-pixel binning for columns and rows
4x2 – Four-pixel binning for columns, two-pixel binning for rows
4x3 – Four-pixel binning for columns, three-pixel binning for rows
• PAN

The PAN menu provides an option for resetting the PAN if an error occurs. See Section 6.1, Troubleshooting, for more information on resetting the PAN.

• Tools

The Tools menu provides these options:

Engineering GUI – for Engineering use only.

Debug log – launches a MOP debug log window. (automatic at startup)

Reset MOP – resets MOP to a default configuration.

Exit and shutdown PAN – closes the MOP interface and shuts down PAN operation.

Disconnect CCD Voltages - disconnects the clock and bias signals from the CCD devices. This is used before powering down the DHE.

Reconnect CCD Voltages - connects the clock and bias signals to the CCD devices. (automatic at start-up)

• Help

Users Guide

Quick start

Users Guide

Quick Start
3.1 Exposure Configuration

Controls are provided for image exposure time, number of frames to acquire and type of frame. Figure 8 shows the various options.

Exposure Configuration

Figure 8

The Exposure Type should be entered first because the exposure time will automatically be entered based on information entered during the last exposure of the same type. Example: if “Comp” is selected as the exposure type and the last time “Comp” was used, exposure time was 22.0 seconds, then exposure time will remain at 22.0 seconds for this “Comp” exposure until it is changed.

Exposure time may be changed during an exposure any time prior to readout. If exposure time is changed, click on the “Start” button again to update the system.

The number of frames may be changed during an exposure sequence. The system will use the new value after the end of the current exposure.
3.2 User Data

The three items in this area of the MCC window are user editable. The default value for the title is set to the target name that was entered by the telescope operator. It will be entered into the image header as “OBJECT.”

The default value for the observer is taken from the value entered during the “obsinit” setup procedure or the last values entered by the observer. It will be entered into the image header as “OBSERVER.”

Propid – proposal identification number assigned to the observation run by the observer. This number becomes part of the observation record. See Figure 9.

![User Data](image.png)
3.3 FITS Image Naming and Storage

The user can select a directory in which to save data, a FITS file name prefix and a file number.

- The File name field on the Monsoon Camera Control window is used to select the name of the image FITS file. When naming the file, avoid spaces and punctuation as UNIX file naming conventions can be particular.

- The data directory button is used to change the directory where data is saved. Left click the button to display the Choose Directory window as shown in Figure 11.
The current default directory for data storage is displayed on a button as shown in Figure 10. Left click the button to select a different storage location. See Figure 11.

![Choose Directory](image)

- The auto-incrementing sequence number is automatically added to the image file name. In the example in Figure 10, the saved image file name would then be:
  
  `/data0/observer/tests/dw_007.fits`

**NOTE:** The sequence number may be located elsewhere in the file name and have a different format if required. Note that “C” language syntax format specifications will apply.

**Example:** A file name of “m101_%5.5d_narrowband3” entered in the Selection field would result in an image file name of:

`M101_00001_narrowband3.fits`
3.4 Comments Area

General comments about an image may be entered into this area as shown in Figure 12. Avoid quotation marks, ampersands and other non-alphanumeric content as much as possible.

The contents of this area will be added to the image header as COMMENT keywords. The “auto-clear” option is the default and will clear the Comments Area after each new exposure.

NOTE: Comments may be added up to the time of readout.

NOTE: Maximum size of a comment is TBD
4.0 Observation Control

Once the observation and image parameters have been set and the desired readout mode configured, click the "Observe" button in the Monsoon Camera Control window to initiate an exposure as shown in Figure 13. The “Observe” button changes color and indicates that the software is “working.”

![Monsoon Camera Control window](image)

Exposure Start

Figure 13

The status of the exposure is displayed in the bottom of the Monsoon Camera Control window as shown in Figure 14.

![Frame and exposure details](image)
During an exposure, the Observe area changes to enable the Pause, Abort and Stop functions.

The exposure status area appears after an exposure is started and displays the frame number and exposure countdown timer. If multiple frames were requested, the “Frame#” field will increment as each frame is completed.

The currently exposing image can be aborted by clicking on the "Abort" button. If the image is one of a sequence, then the entire sequence will be cancelled.

There are other usable options in the observe area. They are:

- **Pause** – closes shutter and suspends exposure countdown. The exposure status area indicates “Hold.” See Figure 15.

- **Resume** – reopens shutter and restarts countdown timer.

- **Stop and readout image** – closes shutter and reads out image. The shutter will close approximately two seconds after the button is pushed.
Pause Button

Pause Figure 15

Countdown Timer on Hold

Frame # 1 Seconds: 5 (HOLD)
Once an exposure is completed and the shutter closes, it will take approximately the runtime listed in the Mode Summary Area to read out the image depending on the observation parameters. The approximate remaining time is displayed in the image readout countdown timer as shown in Figure 16.
When the readout is complete, the image data is transferred via ethernet to the MOP computer. This may take a few seconds. See Figure 17.
After an exposure is completed and the image data is transferred to the MOP computer, the exposure status area of the Monsoon Camera Control window will display a “Disk IO” message. If an image with the same file name and sequence number exists in the current directory, a “File exists” pop-up window will be displayed. See Figure 18. The image file name exists on the MOP computer so the options are:

**Yes** – overwrite the existing file and replace it with the new image.

**No** – a save as option is provided to rename the new image.
5.0 Data Display

If the "automatic display" option is selected in the MOP window, then each frame is automatically displayed in the DS9 image display window as shown in Figure 19.

NOTE: This data may be displayed in a ximtool/VNC window depending on the observer’s choice. If ximtool is preferred then the DS9 window must be closed.

To examine the image header, select “Display FITS Header” from the DS9 window File menu. A second window will open to display the data. See Figure 20.
On-line help for DS9 is available at:

6.0 The MOP Debug Log Viewer

This window displays the latest debug message from the MOP and interactions with the PAN computer. The full log is available at:

```
/tmp/mop-debug.log
```

It is a simple ASCII file as shown in Figure 21. Refer to Sections 6.2, 6.3 and 6.4 for MOP Debug file variations.

![MOP debug log](narrative_image)

Typical MOP Debug Log

Figure 21

This window should be monitored for error messages. If error messages are displayed, refer to Section 6.1, Troubleshooting.

6.1 Troubleshooting

In the MOP debug Log represented in Figure 22, there are some error messages to consider. If messages like these appear, pull down the PAN menu in the Monsoon Camera Control (MCC) window and select the Reset PAN option. After resetting the Pan, the MOP Debug Log window should appear as shown in Figure 21. There should be one or more “ppxAsyncResp” messages displayed and all should indicate “success” as shown in Figure 23. If the reset is not successful, repeat the reset process. If repeated resets of the PAN do not result in a successful restart, contact MTN support for additional assistance.
Error Messages

MOP Debug Log with Errors
Figure 22

"AsyncResp:" Messages

MOP Debug Log after Successful PAN Reset
Figure 23
6.2 Typical Startup Log

NOTE: This message set is not visible in the window but is in the log itself.

The normal set of messages when the MOP is started is:

```plaintext
{connected to bench-pan-dtn at port 5142}
{s> ppxReset}
{socket got >OK: ppxReset: Link Reset and Clear Success.}
{s> ppxAsyncResp}
{socket got >OK: ppxAsyncResp: Success.}
{{socket SetMode monsoon.ini}}
{socket got >OK: ppxSetMode: Completed successfully.}
{{socket SetMode benchCCD_DefaultSetup_5644.mod}}
{socket got >OK: ppxSetMode: Completed successfully.}
{{socket ppxSetMemCfg /usr/Monsoon/cfg/_benchCCD/benchCCD_Sequencer_Ramp2us.ucd}}
{socket got >OK: ppxSetMemCfg: Downloaded File
/usr/Monsoon/cfg/_benchCCD/benchCCD_Sequencer_Ramp2us.ucd.}
{{socket SetMode mcbSeqEnable=1}}
{socket got >OK: ppxSetAVP: Success. \ mcbSeqEnable set to
0x00000001<1.000000><}
{s> ppxGetAVP dwnLdFname}
{socket got >}
{socket got >OK: ppxGetAVP: Success. \ dwnLdFname=benchCCD_Sequencer_Ramp2us.ucd<}
{{socket GetAVP expEndTime}}
{socket got >OK: ppxGetAVP: Success. \ expEndTime=0.000<}
{{socket GetAVP expFdir}}
{socket got >OK: ppxGetAVP: Success. \ expFdir=/usr/Monsoon/cfg/_benchCCD<}
{{socket GetAVP expID}}
{socket got >OK: ppxGetAVP: Success. \ expID=<}
{{socket GetAVP expStrtTime}}
{socket got >OK: ppxGetAVP: Success. \ expStrtTime=0.000<}
{{socket GetAVP imageCols}}
{socket got >OK: ppxGetAVP: Success. \ imageCols=0.000<}
{{socket GetAVP imageCount}}
{socket got >OK: ppxGetAVP: Success. \ imageCount=0.000<}
{{socket GetAVP imageDir}}
{socket got >OK: ppxGetAVP: Success. \ imageDir=/data<}
{{socket GetAVP imageFile}}
{socket got >OK: ppxGetAVP: Success. \ imageFile=mmmdd<}
{{socket GetAVP imageRows}}
{socket got >OK: ppxGetAVP: Success. \ imageRows=0.000<}
{{socket GetAVP intTime}}
{socket got >OK: ppxGetAVP: Success. \ intTime=0.000<}
{{socket GetAVP mosaicCols}}
{socket got >OK: ppxGetAVP: Success. \ mosaicCols=1.000<}
{{socket GetAVP mosaicRows}}
```
{socket got >OK: ppxGetAVP: Success. \ mosaicRows=1.000<}
{(s> ppxGetAVP numOutputs)}
{socket got >OK: ppxGetAVP: Success. \ numOutputs=1.000<}
{(s> ppxGetAVP outputCfg)}
{socket got >OK: ppxGetAVP: Success. \ outputCfg=0.000<}
{(s> ppxGetAVP processMode)}
{socket got >OK: ppxGetAVP: Success. \ processMode=0.000<}
{(s> ppxGetAVP pxlCols)}
{socket got >OK: ppxGetAVP: Success. \ pxlCols=2600.000<}
{(s> ppxGetAVP pxlRows)}
{socket got >OK: ppxGetAVP: Success. \ pxlRows=4000.000<}
{(s> ppxGetAVP pxlsPerImage)}
{socket got >OK: ppxGetAVP: Success. \ pxlsPerImage=0.000<}
{(s> ppxGetAVP shutterState)}
{socket got >OK: ppxGetAVP: Success. \ shutterState=0.000<}
{(s> ppxGetAVP xPostScan)}
{socket got >OK: ppxGetAVP: Success. \ xPostScan=50.000<}
{(s> ppxGetAVP yPostScan)}
{socket got >OK: ppxGetAVP: Success. \ yPostScan=0.000<}
{(s> ppxSetAVP colBin=2)}
{socket got >OK: ppxSetAVP: Success. \ colBin set to 2.000<}
{(s> ppxSetAVP rowBin=2)}
{socket got >}
{(s> ppxSetAVP: Success. \ rowBin set to 2.000<)}
{(s> ppxSetAVP mcbSeqEnable=0)}
{(s> ppxSetAVP mcbSeqEnable=0)}
{socket got >}
{socket got >OK: ppxSetAVP: Success. \ mcbSeqEnable set to 0x00000000<0.000000><}
{(s> ppxSetMemCfg benchCCD_Sequencer_Ramp2us.ucd)}
{socket got >}
{socket got >OK: ppxSetMemCfg: Downloaded File /usr/Monsoon/cfg/_benchCCD/benchC
 CD_Sequencer_Ramp2us.ucd.<}
{(s> ppxSetMode benchCCD_Ramp.mod)}
{socket got >OK: ppxSetMode: Completed successfully.<}
{(s> ppxSetAVP mcbSeqEnable=1)}
{socket got >OK: ppxSetAVP: Success. \ mcbSeqEnable set to 0x00000001<1.000000><}

6.3 Changing Readout Mode

The typical set of messages while the readout mode is being changed is:

{(s> ppxSetAVP colBin=2)}
{socket got >OK: ppxSetAVP: Success. \ colBin set to 2.000<}
{(s> ppxSetAVP rowBin=2)}
{socket got >}
{socket got >OK: ppxSetAVP: Success. \ rowBin set to 2.000<}
{(s> ppxSetAVP imageFile=testxxx)}
{socket got >}
6.4 During an Exposure

The typical set of messages during an exposure is:

```plaintext
{socket got >OK: ppxSetAVP: Success. \ \ imageFile set to >testxxx<<}
{{s> ppxSetAVP intTime=2.0}}
{socket got >}<
{socket got >OK: ppxSetAVP: Success. \ \ intTime set to 2.000<}

6.4 During an Exposure

The typical set of messages during an exposure is:

```plaintext
{exposing (obstobuffer)}
{socket got >}<
{socket got >OK: ppxStartExp: Exposure start signal given.<}
{exp =1000, pixelsDone = 0}
{waiting 1000 1}
{exp =999, pixelsDone = 0}
{waiting 999 1}

.....(several waiting messages will be displayed)

{socket got >asyncMsg: OK: ppxStartExp: Exposure is done ID=2454516.398611<}
{Reading out...}
{Progress was : NReads = 55 }
{Tue Feb 19 09:34:46 MST 2008 Tue Feb 19 09:34:48 MST 2008}

7.0 Environment Variables

The MOP sends commands to the PAN and reads back status values using a standard (unix) socket. The IP hostname of the PAN computer is managed by the environment variable PAN_HOST (default is benchpan).

The socket number for the PAN commanding is managed by the environment variable PAN_DAEMONPORT (default is 5142).

The name of the Monsoon CCD configuration in use is managed by the environment variable PAN_DETECTOR.

The socket number for image data transfer is managed by the environment variable PAN_IMGPORT (default is 7001).
8.0 Header Configuration

The telemetry contents of the image headers is controlled by two ASCII format files that are located in:

```
/usr/local/gui/tclsrc/scripts/monsoon
```

The first file is "headers.conf" which contains one header definition per instrument. Each definition is simply a list of telemetry items (MPG router, or MOP metadata) and the order with which they are to appear.

The second file is "telemwiyn.conf" which contains one section per telemetry stream. Each item in the stream is listed with the corresponding FITS keyword information, in the format:

```
Stream tcs.target
    state   COORDS   coordinate system
Stream tcs.time
    UT1      MJDHDR  Mean Julian Date
```

The first item is the MPG router item name, the second is the FITS keyword, and the rest of the line is the FITS comment.

For example, if a new temperature sensor were added to the bench and it is desired to have its value added to the headers:

- make sure the value is available to the MPG router
- edit the headers.conf file to add it (eg bsa.main.newtemp)
- add a line to the telemwiyn.conf (eg in the bsa.main section)
- restart the MOP so it rereads the header definitions

So, if we added the line:

```
bsa.main.newtemp
```

to the “wiyn-bench” header definition in “headers.conf” and:

```
newtemp   BTEMPXY Temperature of xy stage motor
```

to the “stream bsa.main” section in “telem-wiyn.conf”, then the FITS header record:

```
BTEMPXY = '32.4   ' /Temperature of xy stage motor
```

would automatically be added to the image headers.
9.0 Shutting Down – Normal Operation

To shut down the software, pull down the File menu on the Monsoon Camera Control window and select:

Exit – closes the MOP interface. This action will leave the PAN software and detector running in its current state, which is “idle.”

9.1 Power Off System – Lightning or Maintenance Shutdown

Pull down the Tools menu on the Monsoon Camera Control window and select:

- Disconnect CCD voltages and then:
- Exit and shutdown PAN – closes the MOP interface and shuts down PAN operation.

After disconnecting CCD voltages, it is safe to power off the DHE by switching off the power supply (switch on back of rack.)

Power down computers as required.
Appendix MONSOON Observing Platform Bench Customizations

Introduction
The Monsoon Observing Platform (MOP) is designed to be easily configurable and extendable to support new instruments and requirements. It achieves this by being written mostly in the tcl/tk scripting language and making use of “C” only where necessary.
The standard MOP package provides a simple API for adding instrument-specific procedures. These procedures are dynamically loaded at runtime.
Customization files are located in:

```
/usr/local/gui/tclsrc/scripts/monsoon
```
directory and are named according to the instrument name per MONSOON. For example, the WIYN bench ccd monsoon configuration is "benchCCD" so the tcl customization files would be called benchCCD_Specific_Setup.tcl and benchCCD_plugins.tcl.

The benchCCD_Specific_Setup.tcl File
This file usually contains a single procedure called:

```
detectorSpecificSetup
```
which takes no arguments. This procedure is called after the standard MONSOON initializations have been performed by the MOP during startup.
It will normally be used to load a specific .mod mode file.

The benchCCD_plugins.tcl File
This file contains two types of customizations.
First, it implements some of the standard MOP plugin API routines.
Second, it customizes the appearance of the gui and adds the readout mode configuration functionality.
Standard MOP API Routines

These routines have predefined names and interfaces so the default MOP code can call them if they are provided.

benchCCDpanShutdown {} - executes the shutdown mode on the PAN
getInstrumentName {} - returns the name of the instrument
getFilterList {} - NOT USED, the bench gui manages filters
getCCDTemperature {} args - returns current CCD temperature
headerComments {} fid - add user comments to the header
  when this routine is called the fid argument holds the handle of the open FITS header, it writes new keywords to this file using the "$fid put keyword fitsheaderrecorddata" syntax. It should NOT close the file.
headerGeometry {} fid - add detector geometry to the header
  when this routine is called the fid argument holds the handle of the open FITS header, it writes new keywords to this file using the "$fid put keyword fitsheaderrecorddata" syntax. It should NOT close the file.
headerStandard {} fid – add default fields to the header
  when this routine is called the fid argument holds the handle of the open FITS header, it writes new keywords to this file using the "$fid put keyword fitsheaderrecorddata" syntax. It should NOT close the file.
setSetpoint { op val } – requests a new ccd setpoint temperature
setFilter { instr name } – NOT USED, the bench gui manages filters
showCCDTemp {} - simple ascii display of ccd temperature
**Custom Routines**

These routines provide functionality specific to the particular instrument and as such are unlikely to be shared between MOP instances. Their naming convention is selected by the programmer.

benchTelemetry {} - force update of bench MPG telemetry

defaultReadoutMode {} – set the default mode on startup

instrumentMenus {} - adds bench-specific menus for Gain and Bin

setReadoutMode { op newbin } - change the bench ccd readout mode

    The supported values for "op" are the gain selections "low", "med" and "high" and "rebin". If "rebin" is specified then the additional "newbin" argument must be supplied and have one the following values "1x1 1x2 2x2 4x2 4x3"

showro {} - cli debug to show readout mode variables

updateTitle {} - auto update title field from tcs.target.name telemetry